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1 Introduction

1.1 General Information

Pipeline networks designed to supply vital goods such as drinking-water require special and
very thorough monitoring. The pressure values gathered reveal important information about
the fire safety and about the supply reliability of such a supply network. Guaranteeing supply
reliability even during peak times requires prior measurements to be carried out with pressure

loggers.

Pressure loggers are mounted at several spots at the pipeline section. Simulating consumption
leads to a situation of different pressure levels, and the pressure pattern on the particular
pipeline section reveals information about the condition of the pipe. Graphical editing and
comparability of the measurement-related data is reasonable to provide the user with an

overview of the pressure situation found at the single pressure logger locations.

F.A.S.T GmbH has developed the DRULO software to support the user by evaluating the
measurement-related data acquired by the receiver. Due to the software, pressure loggers can
also be programmed for certain measurement purposes. For the user’s convenience, the
acquired measurement-related data can be displayed as a curve, if requested. In addition, the
software features a function that enables the user to eclipse different measurement curves and

to export entire measurements into Excel for further processing.

1.2 Overview of Chapters

This manual has four chapters. First, the Introduction, followed by the chapter Programme
Design. The third chapter is to provide information on the single menus and on the particular

sub-menus. Chapter four lists all the functions available in the various programme fields.



2 Programme Design

2.1 Menu

In order to control the single functions of the programme, there are two different menu
options available. One option is the “File” menu, and the other one is the “Settings”
menu. If you want to close the programme, go to “File“ or press "STRG" + ,E".
Furthermore, this menu allows the saving of single separate measurements on a data medium
or to download a particular measurement from a data medium. Illustration 2-1 below shows

the extended menu.

File
Open Strg-0
Exit Strg-E

Ilustration 2-1: Close file

Several features of the Drulo Control programme, e.g. the language (lllustration 2-2), can be
changed in the “Settings® menu. Furthermore, the serial interface is configured in this
menu, and the database can be set up with the Database Assistant. For further details, please

refer to section 3.2.

Settings

Language ¥ O German
Communication *| ® English

Datahase

Settings

Language b

Communication ¥ Serial

Database

Ilustration 2-2: Settings




Another feature is the menu “Help®“. Here the user can access any information on the
programme version, contact data, and hardware-related information about the read-out board.
For a detailed description concerning the information available please refer to Chapter 3.3.

Ilustration 2-3 shows the menu as soon as the menu has been activated.

Help

Info program

Info reading unit

llustration 2-3: Help menu

2.2 Menu Bar

The menu bar below the “Fi les* und “Settings* menus offers further functions. However,
the usable functions are context-related and thus only available for certain constellations.
When certain functions cannot be used due to the particular context, these de-activated
functions will be shadowed in grey in the menu bar. Illustration 2-4 below shows the menu

bar. For further information on the single functions, please refer to section 3.4.

Seeaxe gENR

Ilustration 2-4: Menu bar

2.3 State Bar

The state bar informs the user about the progress made by the particular functions called. On
the one hand, the user will see a written description of the tasks done and on the other hand,

on the left- hand side, the user can see the progress made displayed in a graphical way.

| I || look for Drulo on Port: O

llustration 2-5: State bar




2.4 Fields

There are two fields offering different functions in the Drulo Control programme. These two
fields are “Drulo and Measurements® and “Measurement Curve®. The particular

functions of each field are context-related and thus only available for specific constellations.

2.4.1 Drulo and Measurement

This is the part of the programme where the measurements saved in the database and the
pressure loggers connected to the read-out board as well as the latest measurements are
displayed (lllustration 2-6). The user will receive detailed information on a particular
measurement or a pressure logger by selecting this measurement or logger. This information
will then be displayed below the field “Drulo and Measurements* and can be used as

additional information on the selected object (Table 2-1).

When an object is selected in this field, the context-related functions of the menu bar will be
activated (section 2.2). When a pressure logger is selected, the buttons one through fife
(IMustration 2-4) will be activated, and when a measurement is selected, the buttons six
through eight will be activated to provide the user with extended functions. For further

information on the single functions, please refer to section 3.4.

Measurement Pressure Logger
Start time serial no.
End time measured value
Intervals time software version
measured values pressure sensor
battery voltage calibration
maximum pressure battery voltage
minimum pressure
difference in pressure

Table 2-1: Additional information




Drulo and Measuremennt

|’ Druckloggerplatine

I,
%} 1-0: 03.05.2007 11:49:....

I,
Lo |[1-1: 03.05.2007 12:48:...

.

%} 1-2: 03.05.2007 13:11....
'n

%} 1-3: 03.05.2007 13:25....

'n
“ | 1-4: 04.05.2007 08:41....

h; 1

Start time: 03.05.07 12:48
End time: 03.05.07 12:58
Messdauer: 0-0:10:0
Interval time: 00:00:01

Measured values: 601

Battery voltage: Jh15Y
max Pressure: 0,037 Bar
min Pressure: 0,000 Bar

Pressure difference: 0,037 Bar

Hlustration 2-6: Drulo and Measurement field

2.4.2 Measurement Curve

The “Measurement Curve“ field displays the values acquired by the pressure loggers as a
line diagram, with the Y-axis showing the pressure at the particular measuring spots on the
time / X-axis (lllustration 2-7). The time unit is hours, minutes, and seconds (HH:mm:ss). If
several curves are to be eclipsed, the time unit can also be set to months or even years

according to the intervals of the single measurements.
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Further functions of this section can be activated through the buttons as shown in Illustration
2-7. When you are looking at a single curve and intend to divide this particular curve into
several curves or to determine the difference between the minimum pressure and the
maximum pressure of a measurement, go to the “Split* and “Calculate” buttons
respectively. Even several diffusing curves can be eclipsed and marked through the
“Overlap” and “Mark* buttons respectively, and certain data sections can be selected and
exported to Excel. For further information on the single functions of this field, please refer to
Chapter 4.

el

G640 |

Messzail, 30,711,909 0004, [max p. GB35 3643, min p. G618.2144, della p, 17 1490986]

6.638

G.635

6632

6,630 |

6.628

6.625

6622

Druck ( mBar)

G620 1

6618 1

6615

G612 |

6.610 1

6.608
00:04:30 00:05:00 00:05:30 00:06:00 00:06:30 00:07:00 00:07 .30
Zeit

llustration 2-7: Measurement curve

-11 -




3 Menu Functionality

Chapter 3 is to explain the single menus and their submenus in detail. Chapter 3.1 starts with
the functions available in the “File* menu, Chapter 3.2 then deals with the “Settings*.
Finally, Chapter 3.3 is to describe the functions of the “Help” menu. The menu bar as well as

the affiliated functions are described in Chapter 3.4.

3.1 Files

3.1.1 Open File

Programme version 1.0.1.5 and higher enables you to save measurements in a separate file in
order to realize any exchange of measurements in connection with another Drulo operation
programme, if requested. If you intend to open a file which always has the ending of “dfl*“,
select “Open* in the “Fi le“ menu or use the “STRG* + “0“ shortcut. A dialogue will then be
displayed where you can select the file to be opened. Click on “Open* in order to load the file
into the programme. Loading the file may take a few seconds and depends on the size of the
file. Once the file has been loaded it can be seen in the “Drulo and Measurements“
section (Chapter 4.1). When you have opened the file, the measurement-related information
are saved in the database and will be displayed every time the programme is started. If you
do not wish to have this information indicated with every start of the programme, delete the

measurement as described in Chapter 3.4.8.

3.1.2 Save File

In order to make the loading of files feasible, the measurement-related files have to have the
ending “dfl*. The “Save as" features and the “STRG" + “S* shortcut respectively helps you

to create such files.

Just mark the particular file to be saved as described in Chapter 4.1. When you have marked
the file, the “Save as* menu option in the “File* menu will be available. Calling this menu
option makes dialogue window appear where you can input the saving path as well as the
allocated name of the measurement concerned. Once you have entered the file name and
selected the saving path, click on “Save” to save the measurement in the new file. When a
measurement has been saved, it is still available in the “Drulo and Measurements*
section (Chapter 4.1). If, however, the measurement you have just saved does not have to

appear in this section, you can delete the measurement as described in Chapter 3.4.8.
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3.1.3 Enter Additional Information

As described in Chapter 4.2.3 the programme offers the option to save additional information
on each measurement in the database. This procedure has, so far, been implemented as
described in Chapter 4.2.3. From programme version 1.0.1.5, the Drulo programme offers
simplified access to this information window through “Additional Information® in the
“File” menu. Please note that the selection procedure as described in Chapter 4.2.3 still has

to be carried out.

3.1.4 Close the Programme

Select “Exit” from the “Fi les” menu or press “STRG* + ”E“ to close the programme. The
measurements do not need to be saved separately as the programme saves them automatically.
Only those measurements showing a red exclamation mark are not saved due to a read-out

error.
3.2 Settings

3.2.1 Language

You can select the desired language for all texts at “Settings” -> “Language®. The
software supports up to nine languages as shown in Illustration 2-2. As soon as the
programme has been installed, English and German are available immediately as these two
languages have been firmly integrated into the programme and cannot be deleted.
Consequently, you can only select English or German in the “Language® menu. If you want
to select another language, a so-called language file has to be created beforehand. For your
support, the programme generates a template for the language file in the ”lang* folder while
the programme is being installed. The ”"lang“ folder is located in the setup directory of the
Drulo Control programme. For example, if you have installed the programme at
“C:\Programmes®, the setup directory of the programme will be found at
”C:\Programmes\Drulo“ and the template for the language file will be found at
”C:\Programmes\Drulo\lang®“. Once you have opened the “lang“ folder, you will see
the template called "Sprache.properties®. This file can be opened and edited either with
the “Editor® programme or with the "Wordpad* programme. However, before you start
editing the file, you will have to make a copy of the “Sprache.properties* file and save
this copy file in the folder as the original template must not be changed to prevent programme

errors. So please never change the template, always change the copy only.
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You can create a copy of the file by clicking on and marking the file with the left mouse key.
Then move the cursor across the marked file and press the right mouse key to open a so-called
pop-up menu. Select “Copy* and press the left mouse key again. Make sure that you insert the
copy into the same folder by going to “Edit" and selecting ”"Past®. You should now have
another language file in the “lang” folder called “Copy of Sprache.properties®. This
copy can now be adapted to your language. When the language has been adapted, the name of
the language file has to be adapted so that the programme can identify and load the file.
Please rename the copy of your language file (“Copy of Sprache.properties”)

according to the following convention:

e French ->“Sprach_fr_FR.properties”

e Spanish -> “Sprach_es_ES.properties”

e ltalian -> “Sprach_it_IT._properties*

e Danish ->“Sprach_da_DK.properties*

e Norwegian -> “Sprach_no_NO.properties”
e Swedish ->“Sprach_sv_SE.properties”

e Portuguese -> “Sprach_pt_PT.properties'

3.2.2 Communication

You have to determine the kind of data transfer in the “Settings* -> "Communication*
menu. The configuration has to be called (“Settings* -> “Communication” -> “serial”)

through the serial interface before the data of the pressure logger can be read out.

=lolx|
Com port: coms -~
o[ g
Data bits: 8 B
s | g
Parity: none v
Flow control: none [~]
serial Settings
) Stress logger

Ilustration 3-1: Dialogue for the interface settings
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The “Com1* Port is selected as an ex works standard. Select the appropriate Com-Port which
the AZ-100 receiver is connected to. All other settings usually do not need to be changed.
When you have changed all the required settings for the Com-Port, you can accept the
changes by clicking on ”Save“. The pressure logger can then be read out as described in

section 3.4.1.

3.2.3 Database

Start the Assistant at “Settings” ->, Database* (lllustration 3-2). The main window of the

Assistant will open up.

Settings

Language b
Communication #

Datahase

Ilustration 3-2: Settings -> Database

Initialising the Database

Click on the “User* button to enter the username and the keyword for database access
(ustration 3-3).

Ik
dump of the SQL-Instructions —
| User

User: roct |

P (i 4 |ooo.| !

Commit || Cancel |

Close

Ilustration 3-3: Database Assistant

In order to initialise the database, please click on the “Commit“ button and then on
“Initialisation®. This will start the creation of the tables (Illustration 3-3). If you do not

want to initialise the database, click on “Cancel* and then on “Close”.
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Note: Any existing data in the database will be deleted when you start the initialisation
process. Therefore, initialise the database only once after the software has been installed. If ,
at a later point of time, the database is updated, the data saved in the database will not be
deleted.

e
dump of the SQL-Instructions

{ | User
EternplDrulo

warning x|
& Attention! '

It exists already a database for the program DruLo in MyS0OL;
if you press >0k<, all data in the database will be deleted.

| DK || Cancel |

lllustration 3-4: Database message

If the database exists already, confirm the message by clicking on "OK* to continue with the
Assistant. Please note, that all data saved in the database will be deleted. If, however, you

want to cancel the database initialisation at this point, click on “Cancel®.
Updating the Database

Sometimes it is necessary to update the database when the entire programme has been
updated. In this case, the Database Assistant will provide the functions required for the
database update. If a programme updates has generated the message that the database has to
be updated, the database update has to be started through the “Update® button as shown in
Illustration 3-3. It is not required for a database update to key in the username or the keyword

for the database. Also, there will be no data deleted during a database update.
Possible Errors occurring during the Update Process

The Assistant does not find the appropriate path. Please check whether or not the stated paths
exists (Illustration 3-5). If the path does not exist, you will have to install the Drulo Control

programme again or contact F.A.S.T. GmbH.
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Datahase initializiation o ] B
dump of the SAL-Instructions

EaternplDrulo ‘

rhark Natahace-

Fleerror x|

® Attention!

The application could not detect the necessary S0OL files.
If this error arises oneself again, please feel free and contact the F.AS.T. GmbH.

E:temp'Drulo'dbscript'createDb.sqgl (Das System Kann den angegebenen Pfad nicht finden)

Close

Ilustration 3-5: Database error 1

The Assistant could not establish a connection to the database. A possible reason may be an
incorrect keyword, or the “MySQL* service was discontinued or incorrectly started, or the
database is blocked by a firewall (Illustration 3-6).

Database initializiation = |EI|1|
dump of the SQL-Instructions

[=na =S | User

x

Attention!

The application could not be connected with the database.

Possible causes: either the database has not heen activated, the connection to the database
is blocked by a firewall or the inputted databas user account is not correct.

Please check and remedy the relevant failure, before start a new initializiation.

Invalid authorization specification message from server: "Access denied for user "111'@'localhost’ {using password: YES)"

Close

Illustration 3-6: Database error 2

Please check if you have entered the correct keyword and if "MySQL" has been started. If you

have installed a firewall, please keep this firewall deactivated during the entire update
process.
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3.3 Help Menu

3.3.1 Programme-related Information

“Info Program® in the “Help® menu contains detailed information on the programme
version of the programme installed as well as the contact data if you wish to get in touch with
F.A.S.T. GmbH. Clicking on “Info Programme* opens the window as shown in Illustration
3-7. The first line of the dialogue window contains the programme version of the programme
installed. The following windows contain our contact data if you wish to get in touch with us.
Especially the indicated internet address is important for you as you there can download any
possible programme updates. Please note that the internet site will give you some helpful

information on the particular updates your convenience.

Program information il

Programwversion: 1.0.1.6

Compamy: F.A.5.T. GmbH

Bossingerstr. 36
D-74243 Langenbrettach

Phone: 0049 (0)7946 92100 0
Internet: www.fastgmbh.de
0K

llustration 3-7: Information program version

3.3.2 Read-out unit

Another useful window, which you can call under “Info reading unit®, is the window
containing the information about the read-out unit connected to the device. This information
is required if you intend to carry out any programme update as some new features for the PC

programme demand a prior update of the read-out unit and of the pressure logger.

Once this function has been called, the window as shown in Illustration 3-8 appears. This
window contains some information about the software and hardware status of the read-out
board and will only appear if the read-out board was connected to the computer, the interface

in the programme was correctly set (see also Chapter 3.2.2), and a pressure logger was
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connected to the read-out unit when this function was to be executed. Otherwise an error
message will appear on the screen. Also, an error may occur while reading out the

information if the read-out board is operated with an older software version.

¥Yersion reading unit |

Software version: 25.5

Hardware version: 1.3

OK

llustration 3-8: Info read-out unit

As already mentioned above, an update for the pressure logger components may be required if
you intend to make use of all the functions offered by the Drulo programme. The new
functions for the pressure logger (see Chapter 3.4.3 and Chapter 3.4.4) require the application
of at least software version 1.4 for the pressure logger and at least version 1.3 for the read-out
board.

3.4 Menu Bar

The following chapter is to explain the single functions available in the menu bar. Similar to
the functions as described in chapter 2.2, availability of the functions depends on the object
selected through “Drulo and Measurements® (chapter 2.4.1). The functions “Read out
the pressure logger” and “Eclipse measurement curves" are not subject to a

certain context and are available permanently.

3.4.1 Reading out the Pressure Logger Q'?

Select this function when you intend to read out a pressure logger. Please note that this
function will not work properly unless at least one pressure logger has been connected to the
read-out board, the read-out board has been connected to the computer, and all relevant
drivers have been installed. Furthermore, the Com-Port has to be configurated as described in
section 3.2.2 before the logger is read out for the first time. As soon as the appropriate Com-
Port has been set, the pressure loggers will be read out when this function is called. The data
is displayed in the “Drullo and Measurements*” field. The read-out process is indicated in
the status bar (chapter 2.3).
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3.4.2 Setting the Time of the Pressure Logger ﬁ

Similar to the “Read out the Pressure Logger* function, this functions demands a
certain configuration of the devices involved: a pressure logger has to be connected to the
computer and the Com-Port must have been set when this function is called for the first time.
Clicking on the “Setting the time of the pressure logger" button will then open
a new window where the time and the date for the pressure logger can be input. Once the
requested data has been input, click on “Save* to make sure that the selected information is
transferred to the pressure logger. If you want to cancel the information input, click on
“Cancel”. If you use a read-out board capable of reading out up to eight pressure loggers
simultaneously, you can tick the “Synchronize Drulos® button and synchronize all
pressure loggers which are connected to the board. This means that the time and date set will

be transmitted to and saved by all the loggers connected.

I
Date: | h8.05.07 —
Time: | 00:51:35—

[ | take over the PC time
[ ] synchronize Drulos
Save Cancel

Illustration 3-9: Settings of the pressure logger

L »
3.4.3 Resetting the Pressure Logger &

With this function, the operator can delete all completetd measurements saved in the pressure
logger. Those measurements which are still to be executed or which are being executed (see
Chapter 3.4.5) will not be deleted and the particular data remains available. Such data has to
be explicitly deleted through the pressure logger’s keyboard, if requested. Please note that the

conditions as stated in Chapter 3.4.1 have to be met in order to apply this function.
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3.4.4 Real-time Read-out (Pressure logger) &5

Another new function from programme version 1.0.1.5 and higher is the real-time read-out
function. This function enables the operator to closely follow a measurement which is just in

process. This means the pressure logger is used in a way similar to a printer.

Usually this function is applied when the pressure logger is integrated (in-built) in the pipeline
section to be monitored. In this case it has to be noted that communication between the PC
and the logger is not established right away as the pressure logger is equipped with an
inclination sensor which prevents communication when in-built. This is to extend the lifetime
of the battery. However, the pressure logger can be put in the communication mode when in-
built by pressing one of the three operating keys of the pressure logger. As soon as one of the
three keys is pressed, some information about the current measurement is displayed. this
mode, communication between the PC and the pressure logger can be established. Put the
read-out board, which is connected to the PC, on the logger display and then read out the
logger as described in Chapter 3.4.1. After a short period of synchronization between the PC
and the logger, the pressure logger will appear as a symbol in the “Drulo and
Measurements* field (Chapter 4.1). Select this symbol and then call the “Real-time
Read-out” function through the task bar. As a consequence, the measurement-related data of
the current measurement will appear according to the particular intervals in the

“Measurement Curve” field (Chapter 4.2).

. 3|
3.4.5 Programming the Measurement W

This function enables the user to program the pressure loggers with up to five measurements.
These measurements can then be read out with the Drulo Control programme. Please note that
the pressure logger is equipped with a ring buffer featuring a memory capacity of up to
240,000 measurement values. Old values are overwritten as soon as the limit of 240,000
values is exceeded. The measurements saved currently and the corresponding measurement
values are displayed in the ”"Measurement Programming®“ window (Illustration 3-10)
below the table containing the measurements to be programmed. It is necessary to keep the
pressure logger and the read-out board connected to the computer during the entire

programming process.
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Setting the Measurement Parameters

The left-hand part of the window (lllustration 3-10) shows a calendar indicating the present
month. The calendar also provides the timetable for the setting of the dates for the particular
measurements. Just move the cursor to the desired date on the calendar and shadow the

particular day by clicking on the left mouse key.

programming measurement . x|
o =11 Start fime Measurementvalues Interval time Recurrences
{Mai | | [2007 |'| 18062007 - 102281 |2 0010 0

o1 02 03 04 05 06
oF 03 09 10 11 12 13
14 15 16 17 (18 19 20
2 2 3 24 15 8 IT
28 29 30 3N

Drulo mesurements: 1  mesurement values: 2 [v] show all measurements
Recurrences

S dayty O weekiy [ 0F number of | accept || agd || pewete || ciose |

Ilustration 3-10: Programming a measurement

When a date has been selected, click on the “Add* button (lllustration 3-10) to open the
window as shown in Illustration 3-11 to input the parameters relevant for the particular
measurement. The date selected for the start of the measurement is displayed in the upper part
of the “Measurement Parameters* window. The “Starting time* box allows you to
modify the time when the measurement is to be started. Just click on the figure to be reset
(hour, minute, or second) so that the cursor is positioned in the middle of the list of numbers
for the hour, the minute, and the second respectively. Then scroll up or down with the arrow

keys at the right-hand side of the box.

The same procedure is required to change the parameters in the “Finishing Time* (date
and time) and “Interval® (time between two measurements) lines. Concerning the intervals
this means that the higher the interval time is set, the fewer measurement values will be

available for a certain fixed measurement time.

Click on the “Accept” button to accept the set measurement-related parameters and on
“Close” (Illustration 3-11) to discontinue the process. If you have clicked on “Accept*, the
measurement will be displayed in the table of the main window (lllustration 3-10), and the
day of the measurement is highlighted blue in the calendar.
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B x|
Date: 18.05.2007

Start time: | ho:22:511
End time: | 18.05.07 | 10:23:01
Intervaltime: | 00:00:10 =

Measured values: 0

Accept Close

Hlustration 3-11: Measurement-related parameters
Deleting a Measurement

If you do not want to send this message to the pressure logger, you can also delete a
measurement directly from the table. Only those measurements which are listed in the table
will be transmitted to the pressure logger when the “Accept® button (lllustration 3-10) is
clicked on. If you want to delete a measurement from the table, you will have to highlight the
particular measurement to be deleted by clicking on the line in which the measurement is

listed. Then click on “Delete” to delete the measurement from the table.
Programming a Measurement

Programming the measurements in the pressure logger is started by clicking on “Accept*
(IMustration 3-10) and will be executed only if at least one and a maximum of five
measurements are listed in the table of the window. In case of five measurement being listed,
the “Add“ button will not be activated. Deleting one or more measurements from the table
will activate the “Add“ button and enable the user to add one or more measurements until a
total of five measurements is listed (see section Setting the Measurement Parameters). When
all preconditions are fulfilled, the measurements will be transferred to the pressure logger as
soon as the “Accept” button has been clicked on. When all measurement data has been

transferred properly, the starting time for the next measurement will be displayed.
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”Repetitions”

With the “Recurrences* feature (lllustration 3-10), the user can repeat a measurement.
Please note that the requested interval (“daily* or “weekly*) has to be set before the first
measurement is added. If a measurement has already been added to the table, the above
setting cannot be changed anymore. However, the number of repetitions can be set before the

measurement parameters are determined.

When the “dai ly* option for a particular measurement has been selected, the measurement
will be repeated every day at the same time. The “number* box shows the number of days on
which the measurement is repeated. For example, if “0” is selected in this box, the
measurement will be carried out once on the particular day as set, but it will not be repeated
on any other day. If “4” repetitions have been chosen, the initial measurement will be carried
out as set, and, additionally, another 4 repetitions of the same measurement will be carried
out. This means that the user will receive a total of five measurements, carried out on 5
subsequent days. The same applies to the “weekly* setting with the measurement being

repeated on a weekly basis instead of on a daily basis.

Please note: If a measurement has been set and a repetition has been determined for this
particular measurement, no additional measurement can be set for the time between the initial
measurement and the repetition of the measurement. Carrying out two measurements at the

same point of time is not feasible.

41
3.4.6 Print out the selected Measurement &

This function is also a context-related function and provides a number of different results
depending on the objects selected in the “Drulo and Measurements* (section 2.4.1). If a
pressure logger has been selected, some information on the pressure logger itself can be
printed out. If a measurement has been selected, the diagram as shown in the "Measurement
Curve* field will be printed out as well as the additional information which were input in the
"Additional Information* dialogue box (section 4.2.3). As soon as the “Print out
the selected Measurement” button has been clicked on, the dialogue window as shown
in Ilustration 3-12 below will appear. This window primarily constitutes a preview of the

document to be printed out.
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llustration 3-12: Print-out dialogue

There are several functions for further document processing available through the menu bar
(Mustration 3-13). The buttons with the magnifying glass enlarge or reduce the size of the
document in the preview dialogue. If the document to be printed out has more than one page,
the user can leaf through the particular pages with the “<* and ”>* buttons. The second box
(Mustration 3-13, from left to right) opens up a dialogue where the user can set the parameters
for the page to be printed out. Here the user can determine the size of the page and the format
of the paper (horizontal or landscape format). Press the first button if you want to print out the

document.

t&% ¢ > & &

llustration 3-13: Menu bar Print-out dialogue
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Ty
3.4.7 Export into Excel @

Here you can export certain measurement values into a Colon Separated Values —CSV- file.

CSV is a data representation procedure where the single values are separated with semicolons

and saved in a file which can be further processed in Excel. Clicking on “Export selected

Measurement* makes a window open up where the storage location and the file name of the

exported file have to be determined. Clicking on “Save* finishes the exporting process. The

functionality of this button is directly available in the detailed view (section 4.2.1). In the

eclipsed version, however, it is necessary to define the section to be exported beforehand. For

further information about the exporting process in the eclipsed mode, please refer to section

4.2.2.

4. speichern x|
Speichernin: | Desktop - |Eﬂ | =5 el
(-] Eigene Dateien ] ffreereport-0.8.7-2 [ printgl [ cec.csv
(] Arbeitsplatz ] Master 3 reminder [ Logger.s
] Hetzwerkumgebung [ neu [ Router [ Messku
] druloSplash ] o2 3 Schlechter [ Messku
] D¥F-Viewer ] org [ bezirke.csv [ Messun
] hex ] plot [ ¥ bezirkstandort.csv | ] Messwe

1 i | I
Dateiname: | |

Dateityg: E=port File

Speichern

Abhrechen

Ilustration 3-14: Export dialogue

b -
3.4.8 Deleting a Measurement @

Measurements which are not required any longer can be deleted. Just highlight the

measurement to be deleted by clicking on it with the left mouse key. Then confirm the button

“Delete selected measurement” to delete the particular measurement from the

database.

- 26 -




3.4.9 Eclipsing Measurement Curves ﬁ_

If you intend to eclipse some measurement curves, you will have to use this button. It enables
you to display measurement curves featuring varying starting times and to equate certain
measurement points and to eclipse the curves in one diagram. As soon as you have clicked on
“Eclipse Measurement Curves®, a new window will open up where you can select the
curves to be eclipsed (Illustration 3-15). You have to tick the curves to be displayed in the
diagram as shown in Illustration 3-15. Then click on the “Accept* button to preview your
selection in the "Measurement Curve* field. If the “Selection of Measurement
Curves* window shows too many measurements, you can assort the table by clicking on the
table head. The assorting criteria are: “starting time“, “finishing time",
“intervals®, and “1d*. For further information on the functions as described above, please

refer to section 4.2.2.

Selectiun x|
Start End Interal Id
03.05.2007 12:43 03.05.2007 12:4548 TN 1-1:03.05.2007 12:43:211
03.05.2007 11:449 03.05.2007 11:549 001 1-0:03.05.2007 11:49:599
03.05.2007 13:11 03.05.2007 1321 0:0:1 1-2:03.05.2007 13:11:13
1-4:
1-3:

04.05.2007 0841 04.05.2007 08:51 0:0:1 04.05.2007 08:41:02
03.05.2007 13259 | 03.05.2007 1335 0:0:1 03.05.2007 1325941

CCEEe

Accept Close

Ilustration 3-15: Selection of the Measurement Curves
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4 Programme functions

The following chapter is to provide you with an overview of the window functionality of the
programme. In section 4.1, the “Drulo and Measurements* field is explained. Here the
data read out at the pressure logger and the corresponding measurement values are indicated.
Section 4.2 is to explain the “Measurement Curve® field where the measurement values

acquired by the pressure loggers are graphically displayed as line diagrams.

4.1 Drulo and Measurements

This field indicates the pressure loggers and measurements connected to the read-out boards
(ustration 4-1, on the left-hand side). Any measurements which have already been input
into the database will be listed automatically under the particular icon of the pressure logger
board upon start of the programme. They have green icons which are to prescind a paper
document. Those pressure loggers which have been read out are listed according to the
measurements saved and have a bluish icon which looks like a logger. If there are any new
measurements listed on the pressure logger which have not yet been saved in the database,
these measurements will be read out automatically by the programme and positioned below
the logger icons in the display.

Start time: 03.05.07 12:48
Drulo and Measurement
‘ Druckloggerplatine End time: 03.05.07 12:58
F.
ﬁ] 1-0; 03.05.2007 11:49.... Messdauer: 0-0:10:0
==
F%] 1-1: 03.05.2007 12:48.... Interval time: 00:00:01

E%] 1-2: 03.05.2007 13:11.... Measured values: 601

F. o
g] 1-3: 03.05.2007 13:25:...
=

L.f Battery voltage: Js1s v
Jf_m] 1-4: 04.05.2007 08:41:...
REH
Q) 1 max Pressure: 0,037 Bar
o

min Pressure: 0,000 Bar

Pressure difference: 0,037 Bar

llustration 4-1: Drulo and Measurements
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In case of any error occurred during the read-out process, the programme will indicate this
error to the user by displaying an error message on the screen. Under certain circumstances,
this message may be generated during the read-out process. If a data set of a measurement has
been read out incompletely, the particular measurement will be marked with a corresponding
icon in the programme. These icons contain a red triangle and a white exclamation mark. You

should then read out the data again by selecting the particular measurement again.

Please note: The programme will not save any measurement with an icon containing a red
triangle and a white exclamation mark. This means that as soon as the computer is re-started,
the particular measurement will not be listed again as it has not been saved in database.

After the programme has been started, only the “Read out Pressure Logger* and the
“Eclipse Measurement Curves* buttons will be activated in the menu bar (section 3.4)
if neither a pressure logger nor a measurement has been selected. Therefore, you can read out
only those pressure loggers in this mode which have been saved to the read-out board (section
3.4.1) or eclipse only those measurements which are already available in the database (section
3.4.9).

In order to use any further functions of the menu bar, you will either have to mark a
measurement or a pressure logger. If you have already marked a measurement by clicking on
it with the left mouse key, the functions “Print out selected Measurement® (section
3.4.6), ,Export into Excel” (section 3.4.7), and “Delete Measurement” (section
3.4.8) will be available. If you have already marked a pressure logger, the functions
“Setting the Pressure Logger Time"“ (section 3.4.2) and “Programming the
Measurement* (section 3.4.5) will be available. The functions “Read out the Pressure
Logger® and “Eclipsing Measurement Curves” are not selection context-related and

are thus available irrespective of the object selected in the display.

Detailed information will be displayed below the “Drulo and Measurements" window
(Hustration 4-1, on the right-hand side) after a pressure logger or a measurement has been
selected. This information depends on the object selected (see also section 2.4.1).

4.2 Measurement Curve

The “Measurement Curves* field shows the values of those pressure loggers as a diagram
which have been selected in the "Drulo and Measurements” field (lllustration 4-1).

However, there will be no information displayed in the “Drulo and Measurements* field.
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The measurement values will be displayed as a line diagram. The Y-axis shows the pressure,
and the X-axis shows the time in hours, minutes, and seconds (HH:mm:ss) for a measurement
curve. If several measurement curves are to be eclipsed, the time unit can also be changed to
months or years depending on the time between the starting times of the particular
measurements. This field also enables the user to gain detailed information about a certain
measurement value by positioning the cursor on the value in question for a short while. The
programme will then issue a so-called “Tool Tip*“ which reveals the date of the

measurement and the exact value acquired at the particular measurement point.

The diagram also features a zoom function to enlarge or reduce the size of the graphic. Just
click on the right mouse key and select the corresponding function in the context menu. The
user has the option to zoom in or out either one of the axes or both axes. As an alternative, a
certain section of the graphic can also be zoomed out, if requested. This section can be
selected by pressing the left mouse key and will be displayed in a larger scale.

Further functions are available through the “Split*, “Calculate®, “Overlap®, or "Mark*
buttons. Section 4.2.1 is to describe the “Split” and “Calculate” functions as these
functions are only available for this particular view, whereas section 4.2.2 is to describe the

remaining two functions.

4.2.1 Detailed View

Additional functions for this field are available through the buttons as shown in Illustration
2-1. If you are working in the Detailed View field, i.e. you are working on the display of a
single measurement curve, you can use the “Split“ and “Calculate” buttons to divide the
measurement curve into several curves or to determine the difference in pressure between the
maximum pressure level and the minimum pressure level occurred during the measurement

procedure.
Dividing the Curve into Sections

The “Split” feature offers the option to extract a certain part or several parts of a curve.
Click on the button and move the mouse cursor into the line diagram. A broken vertical blue
line will be created in the diagram. This line will follow the horizontal movements of the
cursor and is to define both limits (beginning and end) of the section to be extracted. When
you now click on the diagram with the left mouse key and move the cursor to the left, the

programme will create a yellow field in the diagram. This yellow field can be enlarged or
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reduced in size by moving the cursor. Another click on the diagram finishes the creation of
the section to be extracted. Now it is only the blue line which follows the movements of the
cursor. You can repeat this process a couple of times to extract a number of sections into a

separate measurement curve.

101-0/Sub-0: 30.11.,99 00:04 101-0/S0b-0: 30,11 .99 00:06
65,640 1

Messzait;30.11,99 00:04;

G638 |

6.635 |

6632 1

6.630 1

B.628 |

6.625 1

Druck {mBar)

6.622 |

6.620 |

B8.618 1|

6612 |

6610 |

6608 |
00:04:30 00:05:00 00:05:30 00:06:00 00:06;30 00:07.00 00:07:20
Zeit

Ilustration 4-2: Dividing a Measurement Curve into several Sections

When all sections to be extracted have been marked (lllustration 4-2), click again on the
“Split" button to close the process. The marked sections will be removed from the diagram,

and the new measurements will be integrated into the “Drulo and Measurements* field.
Determining the Difference in Pressure

This function enables the user to determine the difference in pressure for a certain
measurement curve. You require two selection areas in the diagram: one red area representing
the high-pressure area and a green area for the low-pressure area. All measurement values
within a selection area will be used for the determination of the pressure difference. This
difference in pressure is calculated on the basis of the average measurement values of the
particular selection area. Illustration 4-3 shows the two marked areas. Once the calculation
process is finished, the results will be displayed in the “Drulo and Measurements” field

(see lllustration 2-6).
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To start the calculation process, click on “Calculate” and move the cursor into the line
diagram. This will generate a broken bluish line in the diagram. This line will follow the

horizontal cursor movements and represents the two section limits (beginning and end).
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Illustration 4-3: Determining the Difference in Pressure

Click on the diagram with the left mouse key. When you move the cursor to the left, a red
area will be created which can be enlarged or reduced in size by moving the cursor. Clicking
on the diagram again finishes the creation of the marking section. The measurement values
required to determine the high pressure level have been marked now. Now it’s the blue line
again that follows the movements of the cursor. The next step is to create the green area in the
diagram to determine the low-pressure average value, which requires the same procedure as
described above with the red area. When you click on the diagram the second time to close
the marking area, the function automatically deletes the marked areas and indicates the

calculated values as shown in Illustration 2-6.

4.2.2 View of eclipsed Curves

In this mode, several diffusing measurement curves can be eclipsed through the “Overlap“
or "Mark" buttons. Also, certain data sections can be selected and then exported into Excel.

The following sections are to describe the above functions in detail.
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Eclipsing

As soon as you have selected the display mode with various measurement series (section
3.4.9), you have the option to eclipse several measurement curves. This function enables you
to eclipse any measurement point of the measurement series (one measurement point per
measurement series). Just highlight the measurement points to be eclipsed by clicking on
them and thus marking them with the left mouse key. Now a vertical red line to cross the
marked point is created in the diagram. Marking another measurement series requires the
same procedure. The set markings as shown in Illustration 4-4 can be deleted by clicking with
the left mouse key on the empty part of the diagram. The markings you had set are deleted
and you can start on new markings. As soon as all new markings have been set, you can start

eclipsing the measurement curves by clicking on the ”Overlap® button.
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Ilustration 4-4: Eclipsing measurement curves

Marking

This eclipse mode also offers the option to export potential measurement values. However,
only those values are exported which have been marked beforehand. As a standard feature,
the function “Export selected Measurement” (section 3.4.7) in this view has not been

activated and cannot be activated before the particular measurement values have been marked.
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llustration 4-5: Marking the sections to be exported

To activate the function, click on the “Mark* button. Now a vertical broken blue line is
created in the diagram and follows the horizontal cursor movements when the cursor is moved
across the diagram. This line defines the limits (beginning and end) of the marking area.
When you now click on the diagram with the left mouse key and move the cursor to the left,
the programme will create a grey area in the diagram. This grey area can be enlarged or
reduced in size by moving the cursor. Another click on the diagram will finish the creation of
the marking area (Illustration 4-5). The function “Export selected Measurement® is
available to the user now. Concerning the export of the marked area, please proceed as
described in section 3.4.7 above. When you have finish the exporting procedure, you can
leave the marking function by clicking on the "Mark* button. The created marking area will
be deleted from the diagram, and the function “Export selected Measurement® will no

longer be available.

4.2.3 Additional Information

The detailed view enables the user (section Detailed View) to lodge additional information on
a certain diagram with the database. This additional information will be printed out when the
diagram is printed out (see Illustration 3-12). If there is no measurement-related information
lodged, the corresponding fields in the measurement protocol remain empty and can be

complemented manually at a later point of time, if required.
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If you want to add certain information to a measurement, please select the particular
measurement in the “Drulo and Measurements” field to make it appear in the
“Measurement Curve” field. Then double-click on the diagram with the left mouse key to
open the “Additional Information“ window. Now you can complement the information
required in the window. Confirming by clicking on the “Accept® button will save the input
in the database. The input can be rejected by clicking on “Close*, the process will be

discontinued.

Additional information x|
Customer: |Cumpany |
Measuring district: |L|:|nd|:|n |
Measuring Location: | |
Job humber: |1 23 |
Identity number : 0815 |
Nominal wicith: o0 |
Material: [N |
Date: | 18.05.07 |
Infio:

Accept Close

llustration 4-6: Additional information
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